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These release notes briefly list new features in the Thermo BioPharma Finder™ 5.0 application (build 5.0.68.8), a 
mass informatics platform for protein characterization of biotherapeutics. Also included are known issues in the 
5.0 release of the application.
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For information on installing the BioPharma Finder software, refer to either the Installation and upgrade section in 
these Release Notes or the DVD insert. For information on configuring and using the BioPharma Finder 5.0 
application, refer to the user guide available as a PDF file or the Help.

Key features BioPharma Finder 5.0 software provides a simplified comprehensive biotherapeutic attribute characterization with 
advanced capabilities to increase throughput and confidence for BioPharma workflows with built for purpose data 
processing, curation, and reporting in a connected environment to streamline and enable collaboration on a global 
scale.

See these sections:

• New in BioPharma Finder 5.0

• Oligonucleotide Analysis

• Peptide Mapping Analysis

• Host Cell Protein Analysis

• Intact Mass Analysis

• Top Down Analysis

New in
BioPharma

Finder 5.0

The following are new features in BioPharma Finder 5.0:

• Simplied comprehensive biotherapeutic protein attribute characterization with advanced capabilities to increase 
throughput and confidence for peptide mapping workflows with built for purpose data processing, curation, and 
reporting in a connected environment to streamline and enable collaboration on a global scale.

• New capabilities to advance biotherapeutic protein attribute characterization workflows including; Sequence 
confirmation, Quant of peptides & mods, Identification of disulfide links, Sequence variant analysis, De novo 
sequencing, O & N glycan identification, Host cell proteins (HCP), Hydrogen Deuterium Exchange (HDX) 
protection factor plots, Trend analysis, and Multi-attribute method (MAM) method development and 

• Dynamically collaborate, compare, track and finalize peptide results and workbooks using versioning history.
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• Comprehensive and easy-to-use built-in peptide mapping reporting functionality, including:
 New default templates, or, you can design and share your own report templates to publish curated result 

reports in PDF or .xls file formats.
 Tailor report content with the report designer functionality including dynamic data tables, column filters, 

custom calculations, charts and graphs, and images, such as peptide coverage maps.
 Custom report templates that you can use to implement standardized result reporting protocols

• Access and save results in a single secure location using shared sign-on for the entire workflow for enhanced data 
integrity and security.

• Connectivity streamlines and enables collaboration on a local and global scale, including.
 Seamless data processing capabilities by multiple users across any computer connected to the virtual private 

cloud or on-premise server.
 An all-encompassing solution for peptide mapping analysis for data processing, review, and reporting.

Oligonucleotide
Analysis

Features in the Oligonucleotide Analysis workflow include the following:

• The identification feature for oligonucleotide analysis has been expanded to include in silico mRNA digestion 
and mRNA mapping.

• Select from the common RNases or add a custom RNase and the software will identify the mRNA pieces using 
MS2 or full scan data and provide sequence coverage map.

• Expanded sequence matching for oligonucleotides in the intact mass analysis workflow with the addition of 
terminal truncation searching capabilities from both the 3’ or the 5’ terminus.

• Improvements have been added for manual validation of the MS2 spectrum in both the peptide mapping and 
oligonucleotide analysis workflows. The user can view the theoretical fragments, control the fragments displayed 
on the MS2 spectrum and the sequence coverage map.  You can also view the delta mass for the matching. This 
provides deeper investigation into the matched identification. 

• Performs a complete characterization of nucleotide-based pharmaceuticals.

• Sequence manager supports DNA and RNA for creation of oligonucleotide sequences.

• You can create customized building blocks subunits including base, backbone linker, 2’ ribose, 3’ and 
5’ terminus.

• Editing sequences with customized building blocks is achieved using a simple user interface allowing for 
maximum editing of all key components.

• Confirmation of oligonucleotide sequence with a novel MS2 prediction algorithm, providing extra confidence in 
your oligonucleotide sequence. 

• Comparative analysis of multiple samples an ideal workflow for bioanalysis. 

• Automatic identification and annotation using MS2 data utilizing both HCD and CID fragmentation modes. 

• New peak detection that allows for monitoring of expected impurities but also provides results for detection of 
unexpected impurities or metabolites. 

• MS2 confirmation provides site specific localization of modifications or failure sequence. 

• Confirmation of expected and unexpected modifications

Note  The above features are provided in BPF 5.0 with connectivity between Thermo Scientific HyperBridge™ 
software and Thermo Chromeleon™ Chromatography Data System (CDS).

• HyperBridge software. The HyperBridge software provides centralized and secure data storage for 
enhanced collaboration and knowledge sharing. 

• Chromeleon Enterprise Chromatography Data System. Chromeleon Enterprise Chromatography Data 
System 7.3.1 manages all analytical processes from instrument control, data storage and processing, to 
generating the final results on CQAs and new peak detection in both development and QC environments. 
Chromeleon CDS provides ease of administration, ensures continuous update (24/7/365) and meets 
modern data integrity and regulatory requirements. 
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Peptide
Mapping
Analysis

Features in the Peptide Mapping Analysis workflow include the following:

• Confirmation of amino acid sequences with a novel MS2 prediction algorithm, providing extra confidence in 
your peptide sequence assignments.

• Identification of the site and type of expected and unknown post-transitional modifications (PTMs), providing a 
relative amount of modification in the sample.

• Disulfide bond mapping.

• Detection of low-level impurities and sequence variants.

• Sequence alterations in stress samples, including the deamidation or oxidation level.

• Error-tolerant searches for unexpected modifications.

• De novo sequence searches for unknown components.

Host Cell
Protein

Analysis

Features in the Host Cell Protein Analysis workflow include the following:

• Host cell protein identification and quantitation is added to the peptide mapping analysis and combines product 
specific peptide mapping results with host cell protein identification.

• This easy to use workflow starts with a peak list where the software identifies all of the product specific peptides 
considering all potential modifications (normal peptide mapping), then remaining unmatched peaks with MS2 
information are searched using Comet against larger host cell protein databases (for example, CHO, Human, 
Mouse).The results are then merged. 

• The software automatically generates a quantitation report for the host cell proteins and includes the product 
specific sequence as well. If more than 3 peptides are identified from the protein, the software selects the most 
abundant per file, reducing the time the user must manually determining the values.

Intact Mass
Analysis

Features in the Intact Mass Analysis workflow include the following:

• Mass confirmation of target sequences including both proteins and oligonucleotides.

• Confident deconvoluted molecular weight of proteins in both acidic and native conditions. 

• Batch-to-batch analysis for sample comparison.

• Novel sliding window algorithm to improve detection on low-abundant species. 

• Two deconvolution algorithms. The Xtract algorithm supports high-resolution data (isotopically resolved data), 
and the ReSpect algorithm supports low-resolution data (isotopically unresolved data). 

• Target protein sequence matching, which identifies n-linked glycosylations and other common modifications 
using the intact mass.

• Identification of Antibody Drug Conjugates (ADC) using the sliding window algorithm.

• Default processing method for oligonucleotides. 

• Added support for TSQ data files including a default method processing method

• A protein or oligonucleotide sequence is not required to annotate a deconvoluted mass. You can create a 
sequence using only its mass or chemical formula.

• Improved mass accuracy for the deconvolution of modified oligonucleotides from isotopically resolved data 
using the new sequence-specific isotope table, and the rapid measurement of the intact molecular weight of 
biotherapeutics for structural confirmation and characterization.

Top Down
Analysis

Features in the Top Down Analysis workflow include the following:

• A simple workflow for sequencing intact protein molecules using ProSightBP™ as the core algorithms.

• Ability to compare multiple raw data files with combined interactive fragmentation coverage maps.

• Support for multiple modes of fragmentation: CID, HCD, ETD, EThcD, and UVPD, enabling maximum 
protein coverage.
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System
requirements

These are the minimum and recommended hardware and software configurations required for BioPharma Finder 
5.0 operation.

License
activation

Use the Thermo Scientific Product Licensing wizard to activate (or deactivate) the BioPharma Finder application. 
This wizard offers three different licensing options: 

• Full features (Supports all workflows—Peptide Mapping Analysis, Oligonucleotide Analysis, Intact Mass 
Analysis, Top Down Analysis).

• Various options for licensing the individual workflows.

Activation of these features is dependent on the product purchased and is controlled by the license activation key. To 
add an additional features to the software, contact your customer service representative. 

Before you transfer the license to another computer, you must deactivate the existing BioPharma Finder application 
and then transfer the license key. If you are upgrading from previous versions of Thermo PepFinder™ or Thermo 
Protein Deconvolution, you must obtain a new license key for the BioPharma Finder application.

 To activate (or deactivate) the BioPharma Finder application
1. Open the Product Licensing wizard as follows:

a. Open the BioPharma Finder application.
b. Choose File > About BioPharma Finder to display the License Activation wizard.
c. Click Activate (or Deactivate) to start the activation or deactivation process, as applicable.

2. Locate the activation code as follows:
a. Log in to your account at thermo.flexnetoperations.com.
b. In the left navigation pane, under Software & Services, click Order History.
c. From the list of ordered products, click the order number.

The order number is in the Thermo Fisher Scientific “Your Order is Ready” email message. The Order 
Details table provides the activation code in the last column.

3. Continue through the Product Licensing wizard to activate the license using the activation code.

System Minimum requirements Recommend requirements

Hardware • Memory configuration 32 GB RAM 

• CPU  8 cores

• 100 GB storage hard drive

• Resolution display 1920 ×1080 (SXGA)

• Optional: DVD/CD-ROM drives

• Memory Configuration 64 GB RAM

• CPU  8 cores, or a processor with higher cores

• 2 TB storage hard drive (solid state boot drive 
(SATA) for best performance)

• Resolution display 1920 ×1080

• Optional: DVD/CD-ROM drives

Software • Microsoft™ Windows™ 10 (English) 
(64-bit)

• Microsoft .NET 4.8

• Microsoft Office 365

• Adobe™ Acrobat™ Reader™ DC

• Microsoft Windows 10 (English) (64-bit)

• Microsoft .NET 4.8

• Microsoft Office 365

• Adobe Acrobat Pro DC

Note  BioPharma Finder 5.0 connection with HyperBridge is only supported using Microsoft Windows 10 
operating system and will not work with older operating systems.

thermo.flexnetoperations.com
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Installation
and upgrade

Follow these instructions to install the BioPharma Finder 5.0 software. You must be a system administrator on the 
installation computer to install the software. You may license the application as either an administrator or as a 
standard user.

 To install BioPharma Finder 5.0 software
1. Close all active Thermo Scientific™ applications.
2. Insert the BioPharma Finder 5.0 DVD into the DVD/CD-ROM drive. 

The autorun program automatically launches the installer wizard. If the wizard does not start, navigate back to 
the DVD in Windows Explorer and double-click BioPharmaFinderSetup.exe. 

The Welcome to the Thermo BioPharma Finder Suite Installer page opens.
3. Click the links to view the installation instructions, release notes, validation certificate, example data, and 

documents. Then click Next. 
4. View the entire license agreement as needed and select the check box to accept the licensing terms. 
5. Click Install. 

The wizard automatically checks the minimum system requirements. If there are missing items, a summary 
report opens with the appropriate links to download and install the required applications.

If you are upgrading from legacy software, the installer does the following:

• Detects legacy software (BioPharma Finder or Protein Deconvolution), uninstalls the legacy software, and 
then upgrades the data. To proceed, click Yes. 

• Automatically backs up your legacy results onto the computer and upgrades these results to be compatible 
with the new software version.

6. If you want review the IQ report after the installation is completed, click the corresponding link. Click Launch 
to open the application, or click Close to exit the wizard. 

7. Start the Thermo BioPharma Finder application from the desktop icon or from the Start menu, and then 
activate a license as follows:

• If you have a demo version of the BioPharma Finder application, use the 60-day trial license. 

–or–

• If you purchased the BioPharma Finder application, set a permanent license using the activation code 
provided through your account.

 To upgrade from BioPharma Finder 3.0 version to BioPharma Finder 5.0 version

During the upgrade of a previous version of BioPharma Finder, two main software folders, 
C:\ProgramData\ThermoScientific\Databases and C:\ProgramData\ThermoScientific\BioPharma, are 
automatically backed up. 

Copies of the files are placed in the following location using this notation:

C:\ProgramData\ThermoScientific\BioPharmalegacy application version number_backup_DateAndTime 

When the software is successfully installed, you can delete the backup files or move them to another archive location 
to save space on the processing computer. 

 To upgrade from BioPharma Finder 2.0 and previous versions, and upgrade from Protein Deconvolution to 
BioPharma Finder 5.0 version

The upgrade from these older versions of BioPharma Finder is not directly supported by BioPharma Finder 5.0 
version and requires a step upgrade.

When you upgrade from BioPharma Finder 2.0 or previous versions and install BioPharma Finder 5.0 version, the 
installer shows a message stating this upgrade is not supported. See the installation instructions for details.

Note  If you downloaded the installer from Flexera™, click BioPharmaFinderSetup.exe to start the installer.
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Xcalibur
security

patch

The BioPharma Finder installer includes a recently distributed security patch for the Xcalibur™ data system. This 
patch is applied automatically, requiring no user interaction. If the Foundation platform is not installed, the patch 
will have no effect. For more information about the patch, consult the following website: 

https://www.thermofisher.com/software-update

 To reapply the Xcalibur/Foundation update
1. Locate the command prompt (cmd.exe) on your processing computer, and then right-click and choose Run as 

Administrator. 

The Windows command prompt opens with Administrator permissions.
2. Navigate to the directory where you unzipped the update files, and then press the ENTER key. 

3. Type ThermoXcaliburFoundationSU.exe /uninstall /quiet and press ENTER.
4. Type ThermoXcaliburFoundationSU.exe /install /passive and press ENTER.

The Xcalibur/Foundation Security Update window opens, and then closes when the installation is complete

Resolved
issues

Table 1 lists defects that were resolved or are no longer relevant in the BioPharma Finder 5.0 application. The table 
excludes Help issues and cosmetic fixes. In some cases, the abstract has been amended or extended from the original 
to better describe the reported issue. Both an engineering fix and follow-up testing (verified by our product 
evaluation department) have resolved each of these issues. 

Note  You must reapply the Xcalibur/Foundation update if you install, upgrade, or reinstall the Foundation 
platform.

Note  For example, if you unzipped the files to the C:\Update folder, type cd c:\Update, and then press the 
ENTER key.

Note  The table is sorted by software section in ascending oder, and then by the item ID in descending order. 

Table 1.  Resolved issues in BioPharma Finder 1.0, 1.0 SP1, 2.0, 3.0, 3.1, 3.2, 4.0QF, 4.1, and 5.0 (Sheet 1 of 4)

Item ID Software section Abstract

23543 Intact Analysis With 64-bit ReSpect dll delivered with BPF1.0, intensity is very 
different and missing some low-resolution data.

5297 Intact Analysis Save reference for Xtract sliding shows MS scan numbers as –1–1 in 
table and Show Details for Sample Reference.

4754 Intact Analysis There should be a reasonable default value for Sequence Matching 
Mass Tolerance with Da as the unit.

4158 Intact Analysis You can export top level results only for ReSpect sequence 
matching; last row shows as an expandable row like Export All.

5145 Intact Analysis Modification text does not update when switching between peaks in 
the zoomed-in state.

5298 Intact Analysis Adding a sample reference to an Xtract sliding window and then 
saving and running a method does not complete and throws an 
internal exception

4999 Intact Analysis On selecting a result row after zoom and reset scale, the 
chromatogram shows RT range from previously loaded raw data file.

5025 Intact Analysis Run queue becomes corrupted. Experiment type does not match 
Method type—system hangs in processing.

3532 Intact Analysis Report - ReSpect/Xtract Masses table: The order of matching 
sequence + modification is not consistent when compared to the 
deconvolved spectrum and component table in the results view.
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4319 Intact Analysis After the jobs are done, the top jobs (for example, the just finished 
jobs) should be shown.

4234 Intact Analysis There is a user interface style sheet inconsistency among the 
different tabs in Protein Deconvolution 4.0.

3087 Intact Analysis It takes 72 minutes to create 2400 rows using Add Queue. The 
requirement states 8 minutes.

4449 Intact Analysis When copying and pasting from the source spectrum, the blue dots 
are offset from the peaks, which is unexpected.

4637 Intact Analysis Source spectrum is missing, intermittently on a specific file only.

2259 Intact Analysis In Parameters > Chromatogram page, if invalid values are entered 
for the Chromatogram m/z range, it does not show the ToolTip 
about the valid values.

4179 Intact Analysis There is no averaged spectrum when using an ion trap data

“9mix_Lyc_monolith.raw” file.

3388 Intact Analysis “Reset Method” does not work for Chromatogram parameters.

4362 Intact Analysis The XIC for standard Xtract and ReSpect is being represented 
incorrectly.

40758 Peptide Mapping MsFileReader is not installed when running the installer in repair 
mode. Workaround: do not use repair option in BPF 3.0 installer 
instead remove and reinstall.

9206 Peptide Mapping Memory is not released during various operations. Algorithms Layer 
has been fixed and there might be some other workflow where 
memory might not be released. Deferred to next release, so more 
improvements can be made.

38277 Peptide Mapping Refresh issue with loading Protein sequence after reprocessing the 
data, none of tabs are selected

40794 Peptide Mapping When MS2/Full window is changed to floating by dragging the 
window and changed back to "Dockable", MS2/Full data is not 
displayed any more.

15925 Protein Sequence Add glycan list to the default list of variable modification for the 
side chain. This feature will be redesigned in a future release, but a 
workaround exists. Workaround: User can add common glycans as 
the variable modification, instead of using N-gly as CHO or 
Human, so the annotation is more specific.

20475 Peptide Mapping Glycosylated peptides will not be displayed in the results table using 
default parameters because their confidence score will be less than 
80% if you search for them using variable modifications instead of 
the N-glycan database.  Workaround: lower the confidence score to 
0% to observe this type of variable modification or use the N-glycan 
database.

9296 Peptide Mapping Fragment coverage map is shown for components with ID type as 
Full MS. Error in Mass Analyzer: improvement has been made but 
more can be made.

11740 Peptide Mapping Toggling between Fragmentation types and back to original shows 
predicted spectrum with different scaling and labels. Error in Mass 
Analyzer: Scaling might not be that important, users need result 
values to be correct, and MS/MS values are confirmatory only.

Table 1.  Resolved issues in BioPharma Finder 1.0, 1.0 SP1, 2.0, 3.0, 3.1, 3.2, 4.0QF, 4.1, and 5.0 (Sheet 2 of 4)

Item ID Software section Abstract
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63263 Peptide Mapping Peptide Mapping->ID type is incorrect. Workaround - Select the 
MS2 tab and check if the spectrum is displayed. Workaround - 
Select the MS2 tab and check if the spectrum is displayed.

38505 Peptide Mapping In Peptide Mapping the MS ID Type might be incorrectly labeled.  
Workaround: review the results by clicking on the component and 
looking to see if an ms2 spectra appears in the MS2 tab.  If multiple 
files are present expand the table to the raw file level and review each 
raw file for ms2 spectra.

35247 Peptide Mapping Limitation in the component table for displaying peptides with 7 or 
more modifications.

42105 Peptide Mapping Double click on results to open in intact queue and load results but 
this feature is not enabled in Peptide Mapping Analysis

40081 Peptide Mapping Protein coverage results found in the results table under the shading 
chromatogram on the mapping might not agree with the coverage 
results on the protein coverage map.  This can occur for both default 
setting and user defined coverage.  This issue will be address in a 
future release.

40426 Peptide Mapping When a Peptide mapping experiment is deleted from the load 
results tab, mapping tab is not removed. Workaround: exist out of 
the application and restart application.

17270 Peptide Mapping All MS/MS Ion runs do not show Modification summary report.

17143 Peptide Mapping Disulfide + Sodium Adduct - High Negative Delta mass for MS2 
ID rows.

17030 Peptide Mapping Gasphase-NH3Loss - seems like we are using the wrong mass for 
calculation - Delta Mass large than expected.

17015 Peptide Mapping Isomerization for same peptide shows up as two different 
modification masses - shows large delta mass ppm.

14263 Peptide Mapping When Protein Coverage map is copied and pasted to office 2007, 
amino acid is not displayed properly.

62395 Peptide Mapping Peptide mapping->Large experiment -> is only using 1 file for MS2.

62396 Peptide Mapping peptide mapping->ETD/CID select ETD over higher quality CID

4169 Intact Analysis Zooming out to full scale for MS spectrum does not hide the 
scrollbar.  

3238 Intact Analysis Reporting - Source spectrum shows “F:” Assume this is for Filter; do 
not think we have filters for chromatograms.

62577 Peptide Mapping Peptide mapping - After placing an experiment on run queue - 
Home page still has method checked.

62580 Protein Sequence MSQC: Load a non-correct MSQC file - cause exception dialog. 

20965 Peptide Mapping Peptide sequence coverage map does not paste into MS word 
correctly.  

Workaround: use the snipping Windows tools to capture the image 
or do a screen copy.

24538 Peptide Mapping Sometime a peptide might not be highlighted on the protein 
sequence tab.

81000 Installation On a few Win 7 machine, when BioPharma installer is run, the 
installer could get stuck at the "Initializing" step.

Table 1.  Resolved issues in BioPharma Finder 1.0, 1.0 SP1, 2.0, 3.0, 3.1, 3.2, 4.0QF, 4.1, and 5.0 (Sheet 3 of 4)

Item ID Software section Abstract
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Known issues Suggested recovery actions

• For some issues, restarting the application is the appropriate recovery action. 

• As a fix, we generally do not recommend reinstalling the software or the operating system, which more 
commonly occurs after you install a new hard drive. 

• After installing the software on some processing computers, we are seeing an issue with viewing the IQ report 
using the link. If this occurs, you can find the IQ report in the C:\Program Files\Thermo\IQ Reports folder.

Feature requests and other removed items

• We do not include issues where there is insufficient information logged to successfully reproduce the reported 
problem. 

• We do not list feature requests as software issues, regardless of the reported significance or severity of the request. 
Product managers evaluate logged feature requests for future releases. 

• We report only discrepancies in the documented software as known issues. 

42104 Intact Analysis Mass Std Dev and PPM Std Dev present in the report but not 
present in Results table or the export for ReSpect Sliding Window

38707 Peptide Mapping Peptide mapping->Large experiment -> is only using 1 file for MS2.

81326 Installation During upgrade from BF3.0 to 3.1, if there is not enough disk 
space, if a user selects “Ignore"> it still tries to create a backup and 
installation fails.

38396 Peptide Mapping Peptide mapping analysis for single file experiment - for some 
components, id type is displayed as Full, even though MS2 spectra 
and fragment coverage map is present.

78060 Peptide Mapping Peptide Mapping: Save as Displayed: Missing Column "Level" 
causing data overlapping in results grid after exporting to Save As 
Displayed

54723 Peptide Mapping Arrangement of tabs - seen differently than normal right after 
processing.

52377 Peptide Mapping Peptide Mapping->Process & Review-> Mono Mass Theo. does not 
include the Na+

52381 Peptide Mapping Peptide Mapping->Process & Result->Theoretical mass does not 
include oxidation for gasphaseoxidation.

52383 Peptide Mapping Peptide Mapping->process & review-> glycans not be included in 
the theoretical mass value.

52380 Peptide Mapping Peptide Mapping->Process & review->Theoretical mass does not 
have the correct value for dimer peptides.

Table 1.  Resolved issues in BioPharma Finder 1.0, 1.0 SP1, 2.0, 3.0, 3.1, 3.2, 4.0QF, 4.1, and 5.0 (Sheet 4 of 4)

Item ID Software section Abstract
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Terminology

Known defects

Table 2 contains known defects in the software, categorized by software section, with a brief abstract and 
information related to each defect’s severity and risk. The Item ID is the internal number assigned to each issue. 
Product management assesses risk, which can differ significantly from the reported severity.

Severity Interpretation

Critical A problem that renders the system unusable because either an entire function is unusable and no 
workaround exists, or use of the current system compromises data integrity or results in data loss. 
Catastrophic problems also include significant and non-obvious quantitative errors, and all human 
and instrument safety issues.

High A serious issue that does not affect data integrity (meaning data loss, corruption of data, or the wrong 
answer), but affects the customer’s ability to use the product as designed. It can be a failure, design 
issue, or documentation error or omission. A workaround might or might not exist.

Medium A minor error or poor behavior of a product feature. There is probably a workaround.

Low An issue that has a limited effect on customer usage of the product; for defects with visibility so low 
that a customer might never see it; or for ease of use issues or other items not causing any 
performance degradation.

Risk Interpretation

High Occurrence is likely to happen and can compromise operation.

Medium Occurrence is uncommon, but if it occurs, can compromise operation.

Low Issue is minor; however, the software might operate differently from a user’s expectations. A 
workaround is often available.

No Risk This issue causes no problems but is commonly an inconsistency or a 4- Low issue.

Table 2. Known defects (Sheet 1 of 7)

Severity Abstract Risk Item ID

High Shading plots might not be visible in the reports for experiments with 
many data files. 

High 230105

High Duplicate copies of a chromatogram, decon and source spectra (from the 
same raw file) are created for multiconsensus experiment when the raw file 
contains more than 1 component that passes the multiconsensus merge 
parameters.  This might appear as a bug however if you view the raw file 
information the individual component information will be displayed for 
review. 

High 32986

High When remote desktop to a win 10 machine, select Load result or open 
result, it shows a blank screen instead of opening the result in Process and 
review. 

Workaround: Close the application, restart the application, then select 
load result or open result, result is displayed in Process and review.

High 42050

High Memory usage is not optimized during various operations - loading result 
or switch to mapping tab.

High 38744

High The protein sequence information might not be displayed correctly in the 
load results table and identification parameters when upgrading a legacy 
Protein Deconvolution 4.0 result.  

Workaround: to reprocess the results in BioPharma Finder 4.1using the 
same protein sequence (add manually) and then save the results.

High 37244
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High Missing retention time. Design was changed in Protein Deconvolution 
4.0, and this error surfaced as a side error. To fix it requires redesigning the 
algorithm.

Workaround: Close the application, restart the application, then select 
load result or open result, result is displayed in Process and review.

High 10137

High When three chains are added to a FASTA file, components are missing the 
“matched sequences.” This issue is as designed; when three chains are 
added to the same sequence, the target mass of the protein is higher than 
the component. As a result, none of the sequence is matching. This issue 
has been documented in PD 4.0. 

Workaround: Import each chain as a separate FASTA file and add these 
sequences to the method. Sequence match gives expected result. In a future 
release, the algorithm will be updated so that users can add all chains in the 
same sequence.

High 14421

High Copied images from BioPharma Finder to Microsoft Word or 
PowerPoint™ that are then saved as PDF images might be corrupted. The 
Save as PDF command in Word and PowerPoint requires the installation 
of Acrobat Pro to create a PDF, which would then display the images 
correctly in a PDF file.

High 9716

High Performance of “finalizing results” is slow. High 2235

High The Auto ReSpect feature cannot find the expected components. High 3281

High Top Down - Intact - if no deconvolution for specific peak does not update 
deconvolution graph - shows different peak. 

Workaround - Load another result, then load this result again. For intact 
deconvolution - select the empty peak first.

High 63112

High Oligo Analysis only supports 1 variable modification on an oligonucleotide 
sequence

High 117286

Medium Network issues could cause errors with opening large experimental results 
when connected to HyperBridge.

Medium 240503

Medium Theoretical mass of some modifications in the oligonucleotide analysis 
workflow are not correctly calculated for full MS data. 

Medium 185972

Medium Theoretical Protein/peptide manager; custom protease that cleavage on 
both C-term and N-term residues will not cleavage at the N-term side 
correctly.

Medium 179638

Medium In peptide mapping the “find all ions with MS/MS” tasked using as default 
in the host cell protein workflow may generate components that have both 
average and monoisotopic mass equal to zero and contain MS2 spectrum.

Medium 178056

Medium Performance issues could occur when searching extremely large datasets in 
the host cell protein workflow.

Workaround: Increase the S/N value to 3 or greater and reduce the 
retention time range to exclude undigested protein that elutes in the high 
organic. 

Medium 150046

Medium Negative protein terminal variable modifications do not return the correct 
identification for the host cell protein search.  

Medium 164107

Table 2. Known defects (Sheet 2 of 7)

Severity Abstract Risk Item ID
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Medium Application might not respond when user is loading or viewing results for 
top down experiments with more than 25 proteoforms.

Workaround: reduce the total number of proteoforms searched in one 
experiment by performing multiple experiments with less than 10 
proteoforms per experiment.

Medium 177288

Medium Intact experiments that use Respect is still able to be processed, but queue 
show as zero components due to the following situation where report name 
= Raw name + Experiment name + Folder length > 256 characters.

Medium 39291

Medium For intact experiments, when bioPharma 1.0sp1 is upgraded to BF2.0, for 
custom methods RT range is set to 0 to 0 instead of the value set in time 
limit parameter.

Medium 39286

Medium Peptide mapping analysis can have an issue with multiple labels for same 
Glycan in some MS2 spectra.

Medium 38377

Medium QB files for intact Default Native Above 1 million - cannot set RT time to 
include both RT values.

Medium 49511

Medium (UXLib 83877) Licensing - in license activation dialog - when cancel from 
permanent activation and select "back" to select Trial license > activation 
gives an error.

Medium 51905

Medium Peptide mapping-> Process & Review-> Peptide ID has (m) mass but the 
monoisotopic experimental (observed) is 0.000

Medium 52372

Medium Peptide Mapping-> Process and Review-> theoretical mass does not 
include K+ in the mass value and glycans with K+ also.

Medium 52382

Medium Intact - Sliding Window - multiple raw files - match Mass error Percent 
CV - for single raw file should be zero

Medium 52888

Medium Predicted Time - not always the same for processing same experiment for 
Modification summary.

Medium 52946

Medium Peptide mapping analysis: Modification summary relative abundance 
calculations:  When more than one modification is on same peptide, it is 
excluded from numerator.

Medium 38385

Medium Peptide mapping analysis: Monoisotopic Mass - slightly different for 
Targeted verses non-Targeted experiments.

Medium 38376

Medium Peptide mapping->ETD/CID select ETD over higher quality CID Medium 38708

Medium Software does not fully support display on 4k Monitors Medium 38718

Medium Intact deconvolution: drug load values are only assigned to components 
with identifications.

Medium 30767

Medium For multiconsensus Average DAR experiments, if a raw file does not 
contain the component being used for the Average DAR calculation the 
table will display an empty space instead of the raw file name.

Medium 35097

Medium If a processing method has an error the software will allow the user to save 
the method.  

Workaround: do not save methods with errors.

Medium 30357

Medium If multiple resolutions are used during the data acquisition the software 
requires two different processing methods which use the appropriate 
resolution values to obtain the best results.

Medium 24386

Table 2. Known defects (Sheet 3 of 7)
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Medium If raw file folder path and raw file name are > 256 characters, the number 
of components detected in the queue will be listed as 0.  However, the 
experiment will process correctly even those the value is listed as 0.  

Workaround: the value is being displayed correctly in the load results table.

Medium 38426

Medium N-term and C-term modification are not included on the DAR list of 
modifications; therefore, they cannot be used for assigning drug load 
values in this release.

Medium 31909

Medium Override drug load does not work if other rows are checked, when the 
component you want to override is an unchecked row. 

Workaround: uncheck all the components in the main table.  Select the 
component you would like to change the drug load value and check the 
override check box.

Medium 34990

Medium Peptide mapping on hitting abort/cancel can crash application - seems to 
be related to when button is clicked. 

Workaround: if application crashes during aborting reopen to continue 
processing.

Medium 35934

Medium When multiconsensus experiment is exported, the component with a 
rawfile containing multiple peaks, only the first component is exported.  

Workaround is to export all components all levels.

Medium 39426

Medium Application error/crash - when launching a second instance of app from a 
different user on the same machine.

Medium 41418

Medium Disulfide bond is not properly highlighted in Protein sequence tab, if 
peptide sequence is overlapping, then first part of the sequence is not 
highlighted.

Medium 16720

Medium Save results after recalculating average DAR using selected check boxes. 
Open results and drug load are zero for non-checked rows.  

Workaround: Uncheck all rows and then hit recalculate.  The drug load 
values appear for all rows with drug load.

Medium 41362

Medium Single scan raw files exported from Qual Browser can cause the source 
spectrum to be blank when switching from sliding window to average over 
RT. 

Workaround: create a method with sliding window that is within the RT 
range of the file.

Medium 40422

Medium Use restricted time greater than actual chromatogram time - causes 
chromatogram and source spectrum to be empty. 

Workaround: adjust restricted time to fit into the actual chromatogram 
window.

Medium 40735

Medium When BioPharma 1.0sp1 is upgraded to BF3.0, for custom methods RT 
range is set to 0 to 0 instead of the value set in time limit parameter. RT 
range parameter had different meaning in past releases.  

Workaround: change the RT range manually.

Medium 39721

Medium When MS2 window is changed to floating by dragging the window and 
changed back to "Dockable", MS2 data is not displayed any more. 

Workaround: once this error encountered, select another experiment then 
load back this experiment. Data will be displayed. 

Medium 40794
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Medium Resolution displayed on the experimental HCD spectra maybe incorrect. Medium 11778

Medium An apex RT should be within its RT range Medium 11958

Medium When upgrade from earlier version of Protein Deconvolution to 
BioPharma, with Permanent license key, experiment type and load result is 
disabled until restarted.

Medium 13612

Medium (UXLib 14705) When remote desktop to a machine with Trial license for 
biopharma, intact protein is disabled.

Medium 14462

Medium For a mixed data of FTMS Full MS and ITMS full MS, the resolution in 
not correct.

Medium 1918

Medium The user can set different time limits for sliding window and 
chromatogram. During processing, chromatogram window is shown.

Medium 4565

Medium The RT Range for sliding window can be zero for start and finish and, 
when in auto mode, you do not get the sub-optimal warning in the run 
queue message

Medium 4258

Medium Top Down - if you delete the sequence that you have added from Home 
page - protoeform not present after processing. 

Workaround: if the sequence is used in an experiment which is being 
processed or in submitted state, do not delete it from the global reference 
table.

Medium 63260

Medium Peptide Mapping: Best Fragmentation MS2 now selected but Predicted 
MS2 spectrum is not correct fragmentation type. 

Workaround: Manually select the correct fragmentation method in 
"Predicted Peptide MS/MS" dialog box.

Medium 62682

Medium Top Down Xtract parameters Intact deconvolution: M/Z range doesn't 
correspond with the range on the source spectrum's scan filter header 
when Intact Deconvolution is unchecked after selecting RT range. 

Workaround: Manually Change the M/Z range in parameters | Intact 
deconvolution tab and save the method.

Medium 63022

Medium Intact: When queue is paused and BF is upgraded to 3.0, it prompts user 
whether user would like to start the queue> select yes > app crashes. 

Workaround: Process all data experiment in the queue before upgrading to 
higher version.

Medium 61937

Medium Top Down: ProSightBP table is not sorted by relative Abundance on 
initially clicking on proteoform. 

Workaround: User will have to sort manually on Relative Abundance

Medium 62214

Medium MSQC->paste peptide sequences into sequence box with "> name" and 
this information is not being shown in the table.

Medium 60347

Medium Intact->Process & Review->XIC disappear in Auto Peak detection 
experiment when reviewing data. 

Workaround: Reload the result to view the XIC

Medium 60726

Medium Non targeted/Targeted->Multiple (and Single) File Experiment->Predicted 
MS2 not working for some peptides with MS2 spectrum are searched.

Medium 77170

Medium Targeted Peptide Mapping-> Modification Summary->% abundance 
values for modifications that use unique peptides in calculation could be 
incorrect

Medium 79541
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Medium Installer: During installation, the mongodb access dialog should be visible. Medium 81387

Note  An error—error “1920”—might be displayed if a previous version 
of BioPharma Finder is updated to BioPharma Finder 3.1.

Try this workaround: 
1. With the installer is running (displaying the 1920 error), go to 

C:\Program Files\Thermo\BioPharma Finder
2. Select ThermoFisher.BioPharma.DBUpgradeUtility.exe, and then 

run as Administrator.

The "mongodb access dialog" is displayed.
3. Enable access.
4. From the BioPharma Finder installer, 1920 error dialog box, select 

retry.

The Biopharma finder installation is complete.

Medium Peptide Mapping targeted analysis: Modification summary relative 
abundance calculations will not use defined peptides when more than one 
modification is on same peptide, it is excluded from numerator.

Medium 80050

Medium Installer: IQ report link is not working on a few PC/VM-> Adobe is 
installed.

Workaround: Locate the IQ report in IQ Reports directory

C:\Program Files\Thermo\IQ Reports 

Medium 119656

Medium Oligonucleotide Sequence Editor: Gives an error when the formula 
contains any of the elements with an quantity greater than 100,000 (for 
example C101,000H20,000)

Medium 119790

Medium Peptide mapping parameters, beginning and ending peak width, may be 
0.00 when processing an upgraded result from previous versions of BPF. 

Medium 122165

Medium During the installation, if the previous version of BPF is installed but has 
not be launched, during the BPF 4.0 upgrade the installation will fail.

Workaround: Before installing BPF 4.0 ensure that the previous version 
has been opened.

Medium 123001

Medium Oligonucleotide Analysis: For 'Predicted Oligo MS/MS (kinetic model), 
when a sequence is added in all lower case, no message is displayed that it 
should be capital letters or triplet code format.

Medium 123294

Medium Oligonucleotide Analysis: Process and review page, the 3'termins will not 
be highlighted completely in the oligonucleotide sequence page. 

Medium 117056

Medium Peptide Mapping: The chain mass is not updated when linking disulfide 
bond in the protein sequence editor.

Medium 14419

Low The protein description might not be parsed correctly for some host cell 
proteins resulting in an incomplete description in the software.

Low 166116

Low MS Dimer Predicted Spectrum does not show up correctly in dialog box 
for sequence (Assume MS/MS predicted spectrum is incorrect as well).

Low 12896

Low Top Down Analysis: On selecting a method or typing experiment name 
triggers "clear settings" dialog box when home tab is clicked.

Low 61013

Low Top Down: UI items not Properly aligned on Identification tab; PPM label 
is truncated. 

Workaround: This issue is specific to certain VGA card only.

Low 51752
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Low File order is reversed in Result table. Low 53190

Low Peptide Mapping: Performance- Trend MS Area is missing raw file labels 
on x-axis for a 100-file experiment.

Low 73403

Low Peptide Mapping Workbook:  RT (Min) - communicator bar red error 
message does not go away even after fixing it. User has to click on another 
row.

Low 75306

Low Peptide mapping: Clear filter for a column - does not set back to original 
filter type.

Low 38384

Low Peptide mapping: After placing an experiment on run queue - Home page 
still has method checked.

Low 38709

Low MSQC: Selecting peptide or protein shows a table of amino acids - N-term 
is indexed as 1

Low 38710

Low Top Down Analysis: Selecting a method or typing experiment name 
activates the Clear Settings dialog box when home tab is clicked.

Low 38712

Low Top Down: UI items not Properly aligned on Identification tab; PPM label 
is truncated

Low 38738

Low Peptide Mapping: Refresh issue- on Mod summary page upon Manual 
integration.

Low 53410

Low In the summary table found in the parameters save method page, the 
report parameters are listed an enabled for multi-consensus experiments.  
Note that reporting is not a feature for multi-consensus or DAR enabled 
experiments and reports will only be produced for single file experiments.

Low 36231

Low In this release the deconvolution will be processed every time the user 
reprocesses the experiment even if no deconvolution parameters are 
changed. This feature will be redesigned in a future release to improve 
performance.

Low 34061

Low Multi-consensus merging parameters are not disabled for single file 
experiments. 

Low 34626

Low Modification summary export with contents, when viewed using Open 
office is empty 

Low 117636
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Trademarks BioPharma Finder, ISQ, PepFinder, and Protein Deconvolution are trademarks, and Thermo Scientific, Orbitrap 
and Xcalibur are registered trademarks of Thermo Fisher Scientific Inc. in the United States.

The following are registered trademarks in the United States and other countries: Microsoft, Windows, Visual C++, 
and PowerPoint are registered trademarks of Microsoft Corporation. Intel, Intel Core, and Xeon are registered 
trademarks of Intel Corporation. Adobe, Reader, and Acrobat are registered trademarks of Adobe Systems Inc.

The following are trademarks in the United States and possibly other countries: Flexera is a registered trademark of 
Flexera Software, Inc. ReSpect is a trademark of Positive Probability Ltd. Infragistics is a registered trademark of 
Infragistics, Inc. ProSightBP is a trademark of Proteinaceous, Inc.

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries.


	Key features
	System requirements
	License activation
	Installation and upgrade
	Xcalibur security patch
	Resolved issues
	Known issues
	Trademarks


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


